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Chapter 1. Release Notes for version 25.1.1

Contains information about new features, defect fixes, and known issues in Unica Campaign and Optimize that HCL releases 

as part of a scheduled software release.

System requirements and compatibility
Unica Campaign  is part of the Unica  suite of products. Unica Campaign  version 25.1.1 requires Unica Platform  25.1.1

Where to find complete system requirement and compatibility information

For a list of Unica  product versions compatible with this product and a list of third-party requirements for this product, see 

the Recommended Software Environments and Minimum System Requirements  document.

You can also access this document by selecting Help > Product documentation  when you are logged in to Unica.

Prerequisites for using Unica Campaign
Before you begin using Unica Campaign, confirm that your environment meets the following requirements.

• For an improved user experience, use at least a 21" screen.

• To ensure alignment across UX, follow below resolution settings:

◦ Primary Design Resolution: The user experience has been designed for a baseline resolution of 1600 × 900.

◦ Primary Display Resolution for Delivery: The developed solution and demonstrations will follow the 1600 × 

900 resolution to ensure full alignment with the approved designs.

◦ Additional Supported Resolutions: The solution will also support 1440 × 900 (down-scaled) and 1920 × 1080 

(up-scaled) resolutions for consistent usability across common display sizes.

◦ Layout Grid Standards:

▪ 1920 × 1080: Utilizes a 16-column grid

▪ 1600 × 900 & 1440 × 900: Utilize a 12-column grid

◦ Responsive Behaviour: The interface will be responsive across the above supported resolutions to ensure 

consistent user experience.

◦ Recommended Display Settings: For the optimal visual experience and alignment with designed visuals, it is 

recommended to use a 100% zoom level in Windows display settings.

◦ Demo Readiness: Prior to any demonstrations, a visual alignment review will be performed to ensure the 

implemented solution accurately reflects the approved designs.

• A mouse is best for navigating in the user interface.

• Do not use the browser controls to navigate. For example, avoid using the Back and Forward buttons. Instead, use the 

controls that are in the user interface.

• If pop-up blocker (ad blocker) software is installed on the client machine, Unica Campaign  might not function 

properly. For best results, disable pop-up blocker software while running Unica Campaign.

• Ensure that the technical environment meets the minimum system requirements and the supported platforms.*

• The correct browser and versions must be used.*
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• Clear the browser cache after upgrading or applying any fix pack. This only needs to be done once, after the 

application is updated.

• If you use Internet Explorer (IE) with Unica Campaign  or any module that uses Unica Campaign  flowcharts (Unica 

Deliver, Unica Optimize, Unica Interact, Unica Collaborate): To log in multiple times to view side-by-side information, 

open IE and log in to Unica. Then select File  > New Session  in the IE menu bar. In the new IE browser window, log in to 

Unica  as the same or a different user.

Important:  Do not use any other method to open multiple sessions. For example, do not open a new tab; do 

not open another browser session from the Start  menu or desktop icon; and do not use File > New Window  in 

IE. These methods can corrupt information that is shown in the application.

*For details on the items indicated by an asterisk, see the Unica  Recommended Software Environments and Minimum 

System Requirements.

Unica Campaign  documentation roadmap
Unica Campaign  provides documentation and help for users, administrators, and developers.

Table  1. Get up and running

Task Documentation

Find out about new features, known issues, and 

limitations

Unica Campaign Release Notes

Learn about the structure of the Unica Campaign 

system tables

Unica Campaign System Tables and Data Dictionary

Install or upgrade Unica Campaign One of the following guides:

• Unica Campaign Installation Guide

• Unica Campaign Upgrade Guide

Unica Insights Reports for Unica Campaign Unica Insights Installation and Configuration Guide

Implement the IBM Cognos®  reports provided with 

Unica Campaign

Unica Reports Installation and Configuration Guide

Table  2. Configure and use Unica Campaign

Task Documentation

• Adjust configuration and security settings

• Prepare Unica Campaign  for users

Unica Campaign Administrator's Guide
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Table  2. Configure and use Unica Campaign  (continued)

Task Documentation

• Run utilities and perform maintenance

• Learn about integrations

• Create and deploy marketing campaigns

• Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance Unica Campaign Tuning Guide

Use Unica Campaign  functions Macros for HCL Unica

Table  3. Integrate Unica Campaign  with other HCL products

Task Documentation

Integrate with Acoustic Campaign and Acoustic Integration Guide for IBM Marketing Cloud

Integrate with Coremetrics Unica Campaign  Administrator's Guide: How to configure the 

integration

Unica Campaign  User's Guide: Targeting IBM Digital Analytics 

segments in Campaigns

Integrate with Unica Plan Unica Plan and Unica Campaign Integration Guide

Integrate with  Opportunity Detect Unica Campaign  Administrator's Guide: How to configure the 

integration

Opportunity Detect  Administrator's Guide  and Opportunity Detect 

User's Guide: How to administer and use the product

Integrate with Unica Deliver Unica Campaign  Installation and Upgrade guides: How to install and 

prepare Deliver components in the local environment.

Unica Deliver  Startup and Administrator's Guide: How to connect to 

the hosted messaging resources.

Unica Campaign  Administrator's Guide: How to configure offer 

integration.

Integrate with IBM SPSS Modeler Advantage 

Enterprise Marketing Management Edition

Unica Campaign  and IBM SPSS Modeler Advantage Enterprise 

Marketing Management Edition Integration Guide

Integrate with IBM WeatherFX. You can integrate IBM WeatherFX with Campaign so that you can 

pull weather events into your marketing campaigns. Unica Campaign 
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Table  3. Integrate Unica Campaign  with other HCL products  (continued)

Task Documentation

version 9 and version 10 users can integrate with WeatherFX by using 

the UBX toolkit.

Integrate with  Unica Director. Unica Director Installation Guide: You can integrate  Unica 

Director with  Campaign so that you can get status of all the 

running/completed/failed flowcharts, migrate Campaigns from one 

Unica Campaign  environment to other, download/delete flowchart 

logs etc.

Integrate with Journey Unica Campaign can integrate with Journey so that a continuous 

communication with users can be established based on the inputs 

from Campaign.

Refer Campaign Administrators guide > Unica Campaign and Unica 

Journeys integration

Integrate with Link Unica Campaign uses Link capabilities of connectors which include 

the configuration and provisioning to connect to any delivery channel.

Refer Campaign Administrators guide > Unica Campaign and Unica 

Link integration

Integrate with Segment Central Unica Campaign can integrate with Segment Central so that a 

segments can be created and managed based on the inputs from 

Campaign.

Integrate with Audience Central Unica Campaign can integrate with Audience Central so that a 

audiences can be identified and managed based on the inputs from 

Campaign.

Note:  Additional integrations may be available that are not listed in this table.

Table  4. Develop for Unica Campaign

Task Documentation

Use the REST API See the Unica Campaign REST API

Use the SOAP API
• See the Unica Campaign SOAP API Specification

• JavaDocs in devkits\CampaignServicesAPI
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Table  4. Develop for Unica Campaign  (continued)

Task Documentation

Develop Java™ plug-ins or command-line 

executables to add validation to Unica Campaign • See the Unica Campaign Validation PDK Guide

• Java-docs in devkits\validation

Table  5. Get help

Task Instructions

Open online help When using the Unica Campaign  application:

1. Choose Help > Help for this page  to open a context-sensitive 

help topic.

2. Click the Show navigation  icon in the help window to display 

the full help.

You must have web access to view context-sensitive online help. 

Contact  Support for more information about accessing and installing 

Knowledge Center locally for offline documentation.

Get PDFs When using the Unica Campaign  application:

• Choose Help > Product documentation  to access Unica 

Campaign  PDFs.

• Choose Help > All Unica  documentation  to access all product 

PDFs.

• Click the links for PDFs during the installation process.

Google Chrome and Microsoft Edge configuration

Recently, the browsers Google Chrome and Microsoft Edge updated a security fix and this security fix affects the access of 

Unica applications. We have received some issues from our customers like:

• issues with UI

• getting logged out from Unica

These issues are observed due to the change of behavior in browsers after applying the security fix. Applying the security 

fix automatically enables Origin-keyed Agent Clusters by default. If the setting Origin-keyed Agent Clusters by default 

is enabled automatically, it prevents changes in document referrer and domain values so that malicious websites cannot 

execute any type of impersonation. The setting Origin-keyed Agent Clusters by default  existed earlier as well, but was not 

enabled by default.
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If you update Google Chrome or Microsoft Edge to the latest version, you will observe the earlier mentioned issues. Because 

of how Unica is designed and because the Unica suite is deployed over multiple JVMs, it is essential that you disable the 

Origin-keyed Agent Clusters by default  setting for Unica to function correctly and to provide a good user experience.

As a solution, we recommend that you perform the steps mentioned in the following Knowledge Base article: https://

support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185.

Note:  The update to Microsoft Edge browser is very recent and the Knowledge Base article is not yet updated for the 

Microsoft Edge browser.

The CliffsNotes solution is as follows:

1. Open your browser and navigate to one of the following URLs based on your browser:

◦ Google Chrome: chrome://flags/#origin-agent-cluster-default

◦ Microsoft Edge: edge://flags/#origin-agent-cluster-default

2. From the dropdown of the highlighted parameter Origin-keyed Agent Clusters by default, select Disabled.

3. At the bottom of the page, click the Apply Changes  button.

4. Log out of Unica applications, log back in, and verify if everything is working as expected.

New features and changes in version 25.1.1
Unica Campaign  25.1.1 includes a number of new features and changes. These are listed underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software Environments and Minimum 

System Requirements guide.

Upgrade Paths

To upgrade Unica Campaign from your existing version to 25.1.1, you must perform the upgrade as mentioned in the 

following table:

Your existing version Options to upgrade to 25.1.1

10.1.x
• Option 1

◦ Fast upgrade from 10.1.x to 12.1.0

◦ In-place upgrade from 12.1.0 to 12.1.10

◦ In-place upgrade from 12.1.10 to 25.1.0

◦ In-place upgrade from 25.1.0 to 25.1.1

• Option 2

◦ Fast upgrade from 10.1.x to 25.1.1

https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0107185
chrome://flags/#origin-agent-cluster-default
edge://flags/#origin-agent-cluster-default
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Your existing version Options to upgrade to 25.1.1

11.x.x
• Option 1

◦ Fast upgrade from 11.x.x to 12.1.0

◦ In-place upgrade from 12.1.0 to 12.1.10

◦ In-place upgrade from 12.1.10 to 25.1.0

◦ In-place upgrade from 25.1.0 to 25.1.1

• Option 2

◦ Fast upgrade from 11.x.x to 25.1.1

12.0.x
• Option 1

◦ Fast upgrade from 12.0.x to 12.1.0

◦ In-place upgrade from 12.1.0 to 12.1.10

◦ In-place upgrade from 12.1.10 to 25.1.0

◦ In-place upgrade from 25.1.0 to 25.1.1

• Option 2

◦ Fast upgrade from 12.0.x to 25.1.1

12.1.x
• Option 1

◦ In-place upgrade from 12.1.x to 12.1.10

◦ In-place upgrade from 12.1.10 to 25.1.0

◦ In-place upgrade from 25.1.0 to 25.1.1

• Option 2

◦ Fast upgrade from 12.1.x to 25.1.1

12.1.10
• Option 1

◦ In-place upgrade from 12.1.10 to 25.1.0

◦ In-place upgrade from 25.1.0 to 25.1.1

• Option 2

◦ Fast upgrade from 12.1.10 to 25.1.1

25.1.0
• In-place upgrade from 25.1.0 to 25.1.1

25.1.0,1
• In-place upgrade from 25.1.0.1 to 25.1.1
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New features and changes in version 25.1.1

CAM-I-204 Show number of columns exported label near Fields to output or Fields to extract in output 
process.

Show a number of columns exported in bracket near to these labels Fields to output  or Fields to extract  in output process 

box as this will give more information to client as how many columns they are exporting into table or file or extract table.

Timezone in Flowchart Logs

Earlier, it was observed that when flowcharts were executed through a manual run, the correct timestamp was captured 

in the flowchart logs. However, when the flowcharts were executed using a scheduled trigger, an incorrect timestamp was 

recorded. Starting with version V25.1.1, flowchart logs now capture the correct timestamp for both manual and scheduled 

trigger executions.

Fixed defects in Unica Campaign
The following defects were fixed in Unica Campaign  25.1.1.

Issue ID Description

HMA-397659 An error used to appear when running the 

segmentUpgrade  utility.

HMA-354628 Show Decimal Separator According To Locale In Campaign 

Fusion.

HMA-374517 The volume display of Audience processes disappears

HMA-378375 Pasting template takes time when Link PB is present in it.

HMA-387289 [DOC]Remove the reference of V8.6 from Unica 25.1 release

HMA-387548 The column name " Created in " is displayed as " Creation 

Date" for flowchart versioning

HMA-388626 DEFECT: commons-beanutils need to upgrade from 1.9.4 to 

1.11.0

HMA-390700 Postgres_Superset_Campaign_Reports: 

Encountering the error 

'functionpublic.fn_report_convert_date_into_numeric_format

(timestamp with time zone, unknown) does not exist' when 

attempting to open the report name 'Offer Responses for 

Last 7 Days'.

HMA-391219 Superset__ORACLE_LandingPage_Campaign_Reports: Blank 

pages appearing for all landing page reports.
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Issue ID Description

HMA-391725 Upmerge: Databricks: Segment Temp Table not referenced 

properly for delete in between FC runs

HMA-392541 Link process box should use property "duration" instead of 

"fetch_end_date"

HMA-393215 Creating a Maillist via the API results in an error with code 

400

HMA-393224 XSS Injection in Unica Campaign

HMA-393271 Campaign: LogAnalyzer: During the execution of 

LogAnalyzer enabled flowchart an error message can be 

seen in flowchart logs."Endpoint Security Error: Salt is NULL 

or empty!!!"

HMA-393404 [25.1.1] - Upmerge against PMR HMA-392676 - Japanese 

locale UI issues

HMA-393690 Upmerge to PMR - HMA-387402 - Automatic Translation 

of Table and Field Names from Japanese to English After 

Upgrade from 9.1.1 to 12.1.10

HMA-394018 v12.1 : WIN Open JRE – Automatic table mapping is not 

working. DB Authentication pop up is coming even we 

provide correct details

HMA-394162 Installer Suite (Open JRE) 12.1 – Unica: Automatic table 

mapping is failing, and a 1790 error is appearing in the 

Listener logs.

HMA-394311 Vulnerability of poi-3.17.jar

HMA-394522 Campaign: Flowchart scheduler job failing with error.

HMA-394530 Campaign: Campaign Summary Page: Print is not working, it 

is printing blank page.

HMA-394532 Campaign: Offer Central: Print is not working, it is printing 

blank page.

HMA-394891 Campaign: 10637: Cell results are missing; preceding 

processes must be rerun.

HMA-395357 Flowchart suddenly got paused while running.

HMA-395490 Unica Custom Cell attribute - Numeric type to have Negative 

value
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Issue ID Description

HMA-395504 Docker: Campaign: On running the flowchart getting this 

error "10599: Error returned from DataFiltering Server."

HMA-395510 Campaign: Java17: Wrong name is appearing in title of 

Optimize Page when different locale is chosen other then 

English

HMA-396079 This derived field -> string_concat('"', 'Hello', '"'), outputs 

""Hello"" in 12.1.10

HMA-396334 Campaign: Incorrect “Fields to log” count displayed on the 

Log tab in Response process box

HMA-396490 Offer template Name - XSS issue

HMA-396491 Defect for Fix Request- HMA-394030

HMA-396493 DUPLICATE of HMA-393793

HMA-396624 Block special chars in OfferCode

HMA-396923 Campaign v25.1.1: Monitoring is not working on JBoss 

environment.

HMA-397302 Campaign: Incorrect “field to log” count displayed on the Log 

tab in Maillist and Calllist process boxes

HMA-397588 Sesutil is crashing on window and getting core dump error 

on linux

Known issues in Unica Campaign
Unica Campaign  includes the following known issues.

Issue ID Description

HMA-399167 Error when using YEAROF macro in Select Expression — DB 

Error 2624: Column "YEAR" does not exist.

HMA-399168
Error when using MONTHOF() macro in Select Expression — 

DB Error 2624: Column "MONTH" does not exist.

HMA-399584
ADD_MONTHS() macros should run on HP Vertica DB not on 

server.

HMA-399174 When PDF is included in the export and exporting in HP 

vertica database, then error is appearing.
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HMA-399171
Error when using DAYOF macro in Select Expression — DB 

Error 2624: Column "DAY" does not exist.

HMA-398410 Although Campaign installation completed, it 

still had a single non-fatal error when running the 

ace_op_systab_ora.sql  script.

HMA-398184 CampaignID Column having null values in ua_treatment 

table in tango Environment.

HMA-398043 v25.1.1 : Campaign: Swagger : WIN : After executing 

SaveTempalete API , unica_acsvr process of that flowchart 

is getting closed.

HMA-398041 v25.1.1 : Campaign: Swagger : WIN : Getting 

"Internal Server Error":["Status:10404"] error 

in /

campaigns/{destcampaignid}/flowcharts/{flowchartid}/save

template.

HMA-398040 v25.1.1 : Campaign: Swagger : RHEL : Getting 

"Internal Server Error":["Status:10404"] error 

in /

campaigns/{destcampaignid}/flowcharts/{flowchartid}/save

template

HMA-397363 v25.1.1: On Clean install while adding a flowchart error is 

appearing.

HMA-394529 Segment Search: When Segment search is performed with 

the mentioned scenario, error is appearing.

HMA-394515 JBoss appserver: Campaign Setting: Campaign API 

documentation link is going to Not Found page.

HMA-392258 LogAnalyser : In SQLs tab, execution time sorting is not 

working properly.

HMA-392982 If multiple instances are used with same elastic server that 

have the same flowchart ID then elastic search data gets 

overridden.

HMA-392985 After addition of JVM argument 

"-DENABLE_RANDOM_PADDING= true", date picker field is 

appearing blank in Add Campaign form.
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HMA-392226 LogAnalyser : Previous records are getting appended in the 

SQLs tab but when flowchart is reopened again then those 

previous SQLs run get removed from LogAnalyser.

HMA-392222 LogAnalyser: On running the flowchart, log section is not 

updating until I click on LogAnalyser bar and open it.

HMA-384097 Campaign Reports: To view any report, I need to open 

Superset to add embedded.

HMA-386940 AIX : RC Build : Campaign installation is completed with 3 

non-fatal errors.

HMA-386103 Platform: Platform APIs fail when MaxAI is not configured 

with the Unica application.

HMA-381645 Campaign Superset Report: For "Offer Performance Metrics" 

report, in case of percentage value, tooltip value is appearing 

wrong.

HMA-385650 With lengthy offer names in dashboard , offer names should 

be truncated with tooltip

HMA-386155 Superset - Dashboard name and its information is not proper

HMA-386160 MaxAI_Insights: Getting this error "Unable to get Dashboard 

Data, please try again, incase issue persists please contact 

Administrator" Manually need to save charts in Superset UI.

HMA-381621 Campaign Superset Report: For Offer performance by day/ 

Campaign Offer Performance by Month in chart some of the 

column name are not appearing in Korean language.

HMA-387074 Campaign Analytics : Graphs/Tabular: Click on 3 dots 

in right side > Click on Download > "Export to PDF" and 

"Download as Image" are not appearing in translated locale.

HMA-387075 Dashboard Report: Tabular: Grey and Red background is 

appearing behind values.

HMA-386900 Callout: If ExternalCallout template is deleted from 

configuration and user tries to run the flowchart that has this 

deleted callout mapping then crash is appearing.

HMA-386403 Intelligent Flowchart - Add search bar in SQL tab to support 

column-level filtering.

HMA-386396 On Usage Report page not showing campaign Count when 

we take input as csv file.
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HMA-386127 Intelligent Flowchart: While the flowchart is running, the SQL 

tab scroll resets to the top automatically - it should stay at 

the user's current position.

HMA-385448 Campaign Dashboard Report: "Performance" text in report 

name is not appearing in translated German language on 

Dashboard Reports.

HMA-385374 MaxAI : Providing incorrect status information for the 

flowchart "Flowchart 1_MaxAi_Testing"

HMA-385370 MaxAI : Providing incorrect information for the query about 

process box count in Campaign

HMA-385119 Campaign Dashboard Report: Column names are not 

appearing in Spanish translated language for this Campaign 

Financial Summary by Offer dashboard's report.

HMA-384453 Campaign Dashboard Report: Column names are not 

appearing in French translated language for this Campaign 

Financial Summary by Offer dashboard's report.

HMA-384248 Dashboard Superset Report: Column names are not 

appearing in Chinese translated language for Campaign 

Financial Summary by Offer report.

HMA-384228 Campaign Superset Report: Column names are not 

appearing in Chinese translated language.

HMA-378924 Tango-UI: Wrong icon is appearing for some campaigns 

in the favorites section; it's displaying the "Launch a 

Campaign" icon.

HMA-378848 The page becomes unresponsive when the Strategies tab is 

clicked on the Campaign detail page.

HMA-378653 When the Inv button is clicked, the text on the graph's x-axis 

is cut off on the left side.

HMA-376988 Tango_Customize_Dashbords(Superset Reports): Unable 

to see all campaigns name on x axis for Report 'Campaign 

Performance by Offer Responses' .

HMA-376984 Tango_Customize_Dashbords(Superset Reports): for more 

data on any report it should show exact number and not like 

1.02k

HMA-370824 Observed a request call made continuously on Flowchart 

page with errors in weblogic
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HMA-370347 Actian System DB : Getting error "A SELECT statement with 

an INTO clause after the target list may only be used by host 

language SQL, or in a stored (database) procedure" while 

running Segment/Snapshot/MailList/CallList PB's when we 

run Save and Flowchart

HMA-365740 Clean : Postgres : Campaign installation completed with 1 

non-fatal error

HMA-382219 User is able to schedule AB mailing from deliver pb but on 

scheduled time deliver pb fails with an error related API call, 

but on schedule management page the scheduled task is 

populating and also status is updating.

HMA-374645 Superset Reports: Received unexpected error in the 

Campaign Performance Summary by Offer.

HMA-356140 UARE_Loopup_create_oracle.sql Problem in sql script.

HMA-382055 When Campaign contains user data source of type bigquery, 

then upgrading this campaign version to 12.1.10 release 

shows error in upgrade tool execution. This can be ignored.

HMA-381948 Profiling : Not Granted/ Denied user is able to see columns 

data from "Cell Specific Report" model window.

HMA-381664 Allow profiling flag should appear in "partition1" instead of 

"Global Policy".

HMA-381467 Getting WARNING "Malformed password hash 

java.lang.IllegalArgumentException: Invalid encoded 

Argon2-hash" in WebShpere log

HMA-375384 Superset Reports: "Best Offer Lift Over This", "Lift Over Worst 

Offer" columns need to be hide

HMA-375827 Superset Reports: DB2_Data mismatched and offer given 

values axis not available in the DASHBOARD report "Offer 

responses for last 7 days"

HMA-374646 Superset Reports: received unexpected error in the 

Campaign Performance Summary by cell .

HMA-374855 Superset Reports: "What if" offer financial summary" report 

not available

HMA-375504 Superset Reports: SQL_DB Received unexpected error in the 

Report "Campaign Performance Summary by Offer"
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HMA-373443 Snowflake DB : Snapshot PB is giving error when trying to 

export timestamp related field into DB table

HMA-363195 Segment Process Configuration Popup Glows Each Time 

While Selecting Segments

HMA-341415 HCL OneDB Datatype mismatch issue between Unica 

system tables and temp tables

HMA-359362 Weblogic 14 :Lock/Unlock & Concurrent user features might 

not work with real time due to request time out

HMA-353806 Time required to open any campaign or flowchart is 

increased.

HMA-352709 Flowchart lock/unlock not reflecting if user is already in view 

mode.

HMA-353535 FC run label is not updated with current fc run status when 

FC run triggered through Collaborate

HMA-344732 Flowchart Running Icon on toolbar keeps spinning even 

when flowchart is in Paused state

HMA-342778 Publish Offer - Campaign- Contact are not getting generated 

as per package id in Campaign table for multiple offers

HMA-327170 For Docker environment, getting a "Failed to load data" error 

on Schedule management page if user continuously clicks 

on pagination (Next button).

HMA-338254 BigQuery database : Cell size limit causing the Flowchart to 

hang

HMA-337564 BigQuery : table mapping, default string size is taken as 

Maximum

HMA-330433 User is not able to login to platform after upgrade to 12.1.1 

in case Deliver is configured.

Resolution

Execute below query on Platform database :

select * from usm_role_role_map where role_id = (select 

ID from usm_role where name='Deliver_admin' and 

application=101 and partition_id=<>)

Specify actual partition id in above query , default for 

partition1 , partition id =1 , it varies for multiple partitions.
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If above result in more than one row , contact HCL support 

to help in executing below delete query - delete one of the 

duplicate record of *D*eliver_admin role by running below 

query :

delete from usm_role_role_map where role_id = 

(select ID from usm_role where name='Deliver_admin' 

and application=101 and partition_id=<>) and 

parent_role_id=<partition_id>

For example , for partition id =1 ,

delete from usm_role_role_map where role_id = (select 

ID from usm_role where name='Deliver_admin' and 

application=101 and partition_id=1) and parent_role_id=1

HMA-306095 Production documentation links on Campaign installer are 

broken. See the documentation available along with product 

installers.

HMA-310126 eMessage instances in Campaign uninstall folder – these 

can be ignored. Unica no longer support eMessage.

HMA-312231 Campaign swagger APIs will not work only on swagger page 

when marketing platform login method is set to Web Access 

control.

HMA-13460 When the Export to File option is unchecked on the 

Fulfillment tab of the Mail List process, the Summary File 

option is enabled but should not be.

HMA-175825 When defaultBehaviorWhenOutputToFile  is set to Create New 

File, it works only when you select a new output (export) 

file for the first time. If you try to change the existing output 

file and select a new output file, then the option Append to 

Existing Data  gets selected by default. It can be changed 

manually to Create New File.

APAR 198495, PO05293, 198494 For a custom macro, if a user account has assigned as Not 

Granted permission for a stored object (Custom Macros, 

Flowchart Templates, Stored Derived Fields, etc.), the 

custom macro can be used to edit, delete, add, move all 

stored objects regardless of permissions.

HMA-204347 LARGE_DATA: Browser Crash - Mail List process box with 

700 segments - Save with 512 offers to each segment.



Chapter 1. Release Notes for version 25.1.1

HMA-211253 File-based input with multiple columns containing date in 

different format does not read the date correctly.

HMA-212890 Boolean type column on Amazon Redshift is recognized as 

'Test' field type in table mapping.

HMA-220474 When the column name of the source table contains 

Non-ASCII characters and is long (probably longer than 10 x 

3bytes characters in UTF8), the Snapshot process does not 

run because the temp table is not created.

HMA-220705 Profiling count for Dimension table fields is incorrect and 

profiling percentage is displayed as 100% even if profiling is 

in progress.

APAR 222047, PO06172, 222049 Unica Campaign extract process does not write to DB2 

database when flowchart is configured with two extract 

processes and the second extract process contains a 

derived field that uses French accented characters in the 

name of the derived field.

APAR 225568, PO06304, 225572 temptablepostexecutionsql  is not run when selecting 

coremetrics segment.

HMA-230340 Inconsistent behavior for the Mail list process is observed 

when the data filter is assigned to Effective date  on the 

Parameters tab in a new Mail list process when compared 

to an edited existing Mail list process. The Mail list process 

does not output a datetime derived field in the output log 

file. Changing the effective date parameter values might 

cause execution failure of the Mail list.

HMA-230606 In a flowchart where fields are extracted and used in a 

Mail list process, the fields under Extract Node on the 

Personalization tab of the Mail list process are different 

before and after running the process.

HMA-231859 While using the Chrome browser, it takes around 20 seconds 

to respond while loading the Personalization tab of the 

Mail list process if it contains large number of treatments 

and offers assigned. For example, a Mail list process with 

250 cells, each cells with multiple offers, each offer having 

multiple attributes.

HMA-232502 A Mail list performance issue occurs when the user changes 

the input in any way and there is a delay when initially 

switching tabs. After the user changes the input and 
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switches to the Treatment or Process tab for the first time, 

there is a delay of around 10-15 seconds depending on the 

number of inputs selected. After this initial delay, there is no 

delay until the input is changed.

HMA-232835 The Campaign application performance is affected and 

sometimes an exception error message is displayed on the 

Campaign pages when the application is used for a longer 

time (some days) with continuous usage. You must restart 

your Campaign web application and Campaign Listeners.

HMA-238789 While using the Chrome browser, when a user opens a 

Mail list with 600 cells having multiple offers assigned to 

each cell, the application stops responding. While using the 

Internet Explorer 11 browser, nothing is displayed in the Mail 

list process box.

HMA-239142
When the Audience process fails because of an incorrect 

Count filter expression, and the user removes the filter 

expression, adds a Condition, and runs the Audience 

process again, the process fails. The Condition is not 

considered and instead the previous Count filter expression 

is used resulting in the failure. To run the Audience process 

successfully, you must re-open the Audience process 

configuration window, click the Condition, Save and Close. 

The Audience process now considers the Condition and 

runs successfully.

HMA-271642 A "Please wait....."  message is displayed multiple times 

in console mode installation while upgrading from version 

10.1 and also for new Installation

HMA-271676 The Extract table on the DB2 and Oracle databases is not 

deleted when In-DB optimization is unchecked.

HMA-272253 The Campaign application performance is affected when a 

user opens the Table mapping window and more than 500 

tables are mapped.

HMA-2968 Hot keys are not implemented on most of the windows. In 

the Dojo implementation it is not possible to use keyboard 

shortcuts to activate certain functions. Instead the user 

must click buttons.
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HMA-PMR 266519, 75262 Clicking Return to previous page distorts the user interface 

in some cases. Use the links within the products to navigate, 

rather than the browser controls.

N/A When Unica Campaign is deployed in an application server 

cluster environment with 80 port, the Campaign navigation 

URL should not contain this port number. For example: 

http://<host>.<domain>:80/ Campaign should be changed 

to http://<host>.<domain>/Campaign. Change the value of 

the serverURL property under Campaign|navigation on the 

Settings > Configuration  page.

N/A Mail List process box gets unconfigured with error "31606: 

History table are changed" on Flowchart run.

1. There is no issue if the history tables are mapped 

prior to building a flowchart and adding a Mail List 

process.

2. If you do not follow step 1, you can still map the 

history tables after the error appears. If you edit 

the flowchart and configure the process box, the 

process will run.

N/A After migrating non-ASCII data to Campaign, in some cases 

you cannot open Campaign flowcharts on the target system. 

Session flowcharts open successfully. To work around this 

issue, remigrate the campaigns in overwrite mode. You can 

then open the flowcharts.

TT 062333 Information related to associated products does not appear 

in offer on Marketing Operations. When an offer created in 

Campaign with products associated with it is imported in 

Marketing Operations, information about the associated 

products is not available in Marketing Operations.

HMA-270655 Table Mapping : Table name containing @ is supported 

while mapping a table, special characters like @ are should 

not be supported in Table names. Since Table name 

containing @ is supported since some time, this functioning 

is not updated now.

HMA-283637 When user has one maillist PB configured in the flowchart 

and he adds another maillist PB in the same flowchart, it 

is observed that All the values from already configured in 
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treatment tab, Parameters tab, Personalisation tab of new 

Maillist PB appear automatically in any new dragged maillist 

PB.

HMA-281389 While running Campaign in the Upgrade mode, the 

installer should read the installation properties files 

from the previous version response files as we had that 

response available at the install location from the previous 

installation. However, it does not read the installation 

properties files from the earlier version response files.

HMA-280623 In Sample PB if we specify '3' in "# of Samples/Output Cells" 

field and Configure [sample1] with 3 samples having sample 

sizes as 50%, 50% and "All remaining records" respectively 

based on "Random Sample method" then after running 

Flowchart if we reopen the Sample PB "Process run results 

will be lost. Continue?" message is displayed in sample PB 

when remaining All check boxed is check.

HMA-283101 CHROME: "Unable to notify roles/permission changes to 

Campaign, Deliver OD may be out of sync". On clicking 

save changes for the Security Policy displays the following 

pop-up, this happens just first time after user logs in and 

changes anything in the policy and clicks save changes. 

Also, this is reproducible just on CHROME. Tested on 

Chrome V64 and V65.

HMA-282844 Campaign Offer doesn’t sort on 'Channel' & 'Eff./Exp.Dates'. 

After clicking on every column the offers below it should be 

sorted in ascending order. If you click on the same column 

the second time, the offers beneath it should be sorted in 

the descending order.

HMA-283695 Segment process box execution failed with extract enabled 

to User database for the IMPALA user DB. This error does 

not reproduce when extracting to Unica Campaign server.

HMA-284436 Platform.war and campaign.war in ear file deployment 

will not work in Weblogic 12.2.1, work around is to deploy 

campaign.war and unica.war separately.

HMA-288228 If the date field uploaded to IMC side is not in mm/dd/yyyy 

format, the email process box fails to execute. This data 

format is required by IMC Importlist API. It works accurately 

if DELIM_M_D_YYYY(mm/dd/yyyy) format is used for date 

while uploading to IMC using importlist API.
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HMA-289135 TOMCAT : Occasionally Unica Platform or Campaign does 

not gets started after deploying in tomcat application server. 

Workaround : delete Campaign and Platform directory 

available inside Tomcat webapps directory and delete the 

content of work directory from the path where Tomcat is 

installed.

HMA-304945 Refresh command does not refresh the master listener 

priority or weight, if you need to make changes in priority 

or weight you require to take a downtime and restart the 

application.

UL-285 Connection Salesforce - Subsequent Salesforce actions are 

failing for Update (Lead/Contact) intermittently.

UL-250 Connection Mandrill - Intermittenly stop sending emails to 

targeted audiences.

UL-281 Connection Mandrill - Subject line with non english 

characters - mandrill not sending email to user.

UL-259/UL-242 Connection Mailchimp/Mandril - results would be available 

for 1000 users only.

UL-214 MailChimp/Mandril - Audience value is getting changed to id 

field after selection or reopening process box.

UL-194 MailChimp/Mandril - In Mandrill template if merging field 

added as localized character - personalization is not 

working.

UL-257 Link Connections page takes time to load in the Campaign 

process box.

UL-231 Twilio Connection - Only 5 fields are supported for 

personalization in SMS body/text area.q

UL-279 Connection MailChimp - Branch run or single link process 

box run is not supported with Link process box with 

Mailchimp connection. You will need to execute complete 

flowchart.

UL-287 Link process box fails when no output data.

NA Unica Campaign and Unica Link applications urls should 

be having same domain names. Unica Campaign and Link 

applications deployed on different domains will not work.
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UL-189 Connection Mandrill/MailChimp- Emojis are not working in 

Mandrill and MailChimp connector Mail Subject line.

HMA-313650
Platform Scheduled flowcharts are not getting executed 

afterupgrade.Use the quartzjobtool to update scheduler 

jobs. This is a requiredstep. If this upgrade tool is not run, 

any existing scheduled job willfail to start. The quartzjobtool 

is in the tools\bin directory underUnica Platform installation. 

Run this utility from the tools \bindirectory.Example 

command (Windows): quartzjobtool.batExample command 

(Unix): ./quartzjobtool.sh

HMA-316802 MariaDB]:CODE 704: File write error. while extracting 

extracted fields and table fields to database server through 

Segment PB

Known issues in Optimize
The following are the Known Issues for Optimize in V25.1.1

Issue Issue ID Description

Optimize : Max capacity constraints are not be met 

when using offer versions.

HMA-313101 Optimize : Max capacity constraints are 

not be met when using offer versions.

Scores entered manually in the score matrix are not 

considered while optimizing the contact list.

Defect 194109 Scores entered manually should be 

considered for calculation in the 

Customer Capacity rule. However, while 

applying the Customer Capacity rule, 

scores in the PCT are considered, and 

all customer records are removed in the 

optimized list.

Campaign Optimize summary report is incorrect. Defect 176368 If offer versions are used in a rule, the 

report that shows pre-optimization 

versus post-optimization counts will 

always report the pre-optimization 

count of records as 1. The 

post-optimization counts will be 

correct.

After upgrading Campaign to 9.1, Optimize listener 

can no longer be stopped via ACOServer.sh.

Defect 81245
Users must upgrade Unica Campaign 

and Unica Optimize  together. If they 

cannot, they will need to stop the Unica 
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Issue Issue ID Description

Optimize  listener manually through the 

task manager/kill command.

Error messages for the ACOOptAdmin utility do not 

display according to non-English locales.

DEF051284 When you run the ACOOptAdmin 

command line utility in a locale other 

than English, error messages do not 

display according to the specified 

locale. The error messages display only 

in English.

unprocessables_sessionid.csv  might contain 

some customers who receive offers.

DEF054841 In some scenarios, a few 

of the customers who get 

offers might be present in the 

unprocessables_sessionid.csv 

file.

Incorrect optimization result with Custom Capacity 

rule in specific circumstances.

DEF058362
A customer that satisfies the following 

criteria might receive fewer offers than 

wanted:

• The customer has an 

even number of proposed 

transactions.

• Each of these transactions has 

the same score.

• This score is a low value.

Some labels display incorrectly in Japanese, Chinese, 

and Korean.

DEF059595 Some translated labels are displaying 

incorrectly. For example, when you 

edit the score matrix manually, the 

vertical label on the right side of the 

table displays upside down. Also, 

for optimization rules that contain 

customers in the segment, the 

segment  label displays on two lines.

Offer filtering summary report displays an incorrect 

count of Proposed Contacts that are removed by 

each Custom Capacity rule.

DEF059805 The Offer Summary Report displays 

incorrect counts in the "Removed By 

This Rule" column for Custom Capacity 

rules if the participating Flowchart for 

this Unica Optimize  session contains 

multiple contact dates and multiple 
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Issue Issue ID Description

offers that are made to each customer 

on different channels.

Issues with offer version query builder. DEF060676
There are several minor issues with the 

offer version query builder:

• For custom attributes with the 

Form Element Type of Select 

Box, the offer version query 

builder does not use the select 

box. You must enter the value 

manually.

• When the group level is 

removed, the subgroup 

conditions are added to the 

parent condition, and vice versa.

• All arithmetic operators are 

displayed for a string variable, 

but only equal and not equal 

apply.

• Defined length validations for 

attributes are not verified upon 

input for conditions.

Offer version rules that contain dates do not provide 

expected optimization results.

DEF061554 If you create an offer version condition 

that includes a date, such as the offer 

parameter "valid end date" equals 

"12/31/2011", the rule containing 

offer version condition might not be 

satisfied; however, the rest of the rules 

will work as expected.

Rule exceptions that span calendar years give 

incorrect results.

DEF061639 If you create a rule exception to 

a Min/Max # Offers capacity rule 

that spans calendar years, such as 

07/01/2011 to 06/30/2012, the rule 

containing rule exception condition will 

not be satisfied; however, the rest of 

the rules will work as expected.
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Issue Issue ID Description

<unica_svradm> refresh command does not reflect 

the change.

HMA-304945 On a running environment, after 

changing the master listener priority, 

<unica_svradm> refresh command does 

not reflect the change.

<unica_svradm> refresh command does not delete the 

node from cluster.

HMA-305764 If you delete a listener node from 

existing cluster, <unica_svradm> refresh 

command does not delete the node 

from cluster. Execution requests are 

still observed going to the deleted 

node. Restarting the listener solves 

this issue. Will be fixed in upcoming 

fixpack.

Users are still able to manually interfere in the 

running flowchart when flowchart execution is in 

progress through SVRADMIN utility.

HMA-306037 When flowchart execution is in 

progress through SVRADMIN utility 

or using scheduler, user is still able 

to manually interfere in the running 

flowchart. Will be fixed in upcoming 

fixpack.

Known limitations in Unica Campaign
Unica Campaign  25.1.1 includes the following known limitations.

Issue ID Description

305764 For any reason, if users delete the Campaign listener node 

configuration from listener cluster configuration in Unica 

Platform, while the application is up and running then users 

connected to this listener node are not redirected to another 

listener. You must restart the Campaign web application. If 

you require to delete the listener node, take a downtime and 

restart Campaign web and listener components.

17202 Error 19024: Cannot delete segment folder if the segment 

was deleted from the folder. A segment that is deleted 

from a folder remains as an inactive segment in the folder. 

Folders with inactive segments cannot be deleted. This is 

working as intended.
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185854 Big data: Campaign integration with Hadoop-based Hive big 

data as a user data source is not tested on MS Windows 

operating system.

190621 Big data: Campaign with Hive big data as a user database 

does not support user table mapping with Base and 

Dimension levels up to the fourth level hierarchy. If you map 

a Base record table with four levels of dimension tables in a 

Select process box, then build a query based on the fourth 

level Dimension table, the query fails with Error 11528. This 

issue should not affect big data users because multiple 

dimensions should not be needed. By definition, a big data 

source has a large table of records split across Hadoop 

nodes (such as HDFS).

194095 For Redshift database, the error message "Unsupported type 

timestamps with time zone" is displayed when exporting 

data from a Snapshot process box. Timestamp with 

timezone is an unsupported PostgreSQL data type on 

Amazon AWS.

195581 While running a Campaign flowchart, if listener crashes or 

is stopped, user is not able to access the running flowchart 

from the UI. Requests are being served by another node 

of the cluster but while accessing the flowchart, a pop-up 

message says "listener failover occurred..." It may be 

necessary to restart the master listener.

232032 User can start only one Campaign listener on one server 

(machine) in case of Listener clustering.

PMR 243195, 244148 When a column that has the Greek Letters A and B is 

profiled in Campaign, the system returns only A along 

with the count of all the records. After the fix, some of the 

non-English characters, which differ only in case (like é 

and É in French), are counted as two different values in 

profiling. English language characters are not counted as 

case sensitive.

244482 Deep search lists all the Campaigns that are created through 

Marketing Operations projects when Campaign - Marketing 

Operations integration is on. Campaigns that are created 

through Marketing Operations projects when Marketing 

Operations - Campaign integration is enabled) are not 

listed on Campaign list page and are only available on the 
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Marketing Operations project listing page. Users who do 

not have the permission to access Marketing Operations 

are able to access campaigns which are created through 

Marketing Operations projects through Deep search results.

248943 If the user profile database is changed (change in the table 

column values of audience record) for fields other than 

sync fields and the user runs the Email process again, a 

negative count is returned for the DUPLICATES parameter 

from Engage in the Campaign flowchart log.

N/A Big data: To perform the UPDATE operation on any process 

boxes in a flowchart, ensure that your HIVE tables are 

configured as transactional tables such that they support 

the ACID property. This is a key feature introduced in HIVE 

version 0.14.

N/A Interact when configured with IBM WebSphere Application 

Server: You must configure IBM WebSphere JVM to use 

JDK 1.7. When IBM WebSphere Application Server 8.5.5.x 

is configured with JDK 1.7 and HTTPS communication, you 

must use IBM JAVA SDK version 7.0.8.10 or higher.

N/A Using multiple SQL statements for raw SQL queries is not 

currently supported on big data user datasources. For 

related information, search the IBM Knowledge Center for 

Hive query language conformance.

N/A Dialog behavior: In certain cases, it is necessary to click 

twice in order to activate a field or change a field value.

N/A The monitorEnabledForDeliver  configuration property in 

Campaign|monitoring  is not currently used.

N/A Relevant products limitation: When offer management 

is performed from Unica Plan, the "relevant products" 

functionality, which relates product IDs to offers, is not 

available.

N/A Blank or incorrect results from derived fields in a Mail List 

process. This can occur in a process box that uses a derived 

field that calls a Generated field (UCGF) that changes value.

Do not use a UCGF in a Mail List derived field if the UCGF is 

not constant. Also, from the Parameters tab, do not create a 

derived field to call a UCGF to populate offer attributes.
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N/A Profiling a Campaign Generated Field (UCGF) does not yield 

correct results. Some UCGFs have a value according to the 

cell or the offer being processed. For cell-related UCGFs, 

only the value associated with the first cell appears during 

profiling.

N/A The default value for a custom cell attribute does not appear 

when you open the target cell spreadsheet. Although the 

default value is not initially displayed, it will be used. The 

value can be displayed or changed by clicking or opening 

and editing the custom cell attribute in the target cell 

spreadsheet.

N/A The UA_UsrResponseType.Name  field cannot contain a left 

parenthesis followed by a single quote.

N/A
Use unique TempTablePrefix  for each data source when 

mapping multiple data sources to same physical database.

If you mapped multiple data sources in Unica Campaign 

to the same physical database, and you use the same 

TempTablePrefix  for more than one of the data sources, when 

you use the cleanup utility to delete orphaned temp tables, it 

may falsely identify temp tables as orphaned, when they are 

in fact legitimate temp tables defined from a different Unica 

Campaign  data source.

Any deleted temp tables will automatically be recreated 

when you rerun affected flowcharts, but as a best practice, 

use a unique TempTablePrefix  for each data source when 

mapping multiple data sources to the same physical 

database.

If the data sources defined in Unica Campaign  map to 

different schemas in the database, another solution is to 

ensure that the database user who runs the cleanup utility 

does not have privileges to drop tables in other schemas in 

the same database.

161323 The error "Login failed. Error 10553" can occur if you try to 

log in to the Campaign utilities when the Unica Platform | 

Security | login  method is set to Windows integrated login 

or Web access control. To avoid this issue, change the 
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login type to LDAP  or Platform  prior to using the Campaign 

utilities..

176377 DB2 10.5 BLU for user DB: No indexing requirement for 

temp tables in Unica Campaign  datasource. DB2 10.5 

(with BLU feature ON) does not require indexing in Unica 

Campaign. Unica Campaign  has certain properties for 

datasources, such as TempTablePreTruncateRunScript, 

TempTablePostExecutionSQL, and 

PostTempTableCreateRunScript, where you can provide SQL 

or scripts to create indexes on user database tables. If you 

are using DB2 10.5 as a customer database, with the BLU 

feature ON, you do not need to configure any of these temp 

table properties.

201,968,200,241 If two process boxes are moved very close together in a 

flowchart, the direction of the connection arrow changes. 

This limitation affects the visual representation of the arrow. 

The process data flow is not affected. The workaround is 

to move the process boxes farther apart so the arrowhead 

changes back to the correct direction.

211293 In  Unica Campaign, the built-in macro Current_Date() results 

in an error when executed against a Hive 1.2 based Big 

Data instance. The Hive ODBC driver does not support the 

Current_Date macro to obtain interval values. For example, 

executing the following query results in a Hive error:

SELECT DISTINCT customerid FROM Customer_date 

WHERE ((Customer_date.my_date_mmdyyyy - 

CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from 

type: interval_day_time

Workaround: To use the Current_Date function in a RAW 

SQL query on Hive with Hortonworks, execute SQL in the 

following format:

SELECT DISTINCT customerid FROM Customer_date 

WHERE (current_date() - my_date_mmddyyyy ) = interval '0 

0:0:0' day to second

310769 In Unica Campaign, the built-in macro Current_Date()  results 

in an error when executed against Impala data source. The 
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Impala ODBC driver does not support the Current_Date 

macro to obtain interval values. For example, executing the 

following query results in an error:

INSERT INTO TABLE UAC_133824_5 SELECT DISTINCT 

store_id, d_customer_key FROM srvacammo.bast_segment 

WHERE (srvacammo.bast_segment.ba_last_trans_date > 

(CURRENT_DATE - 2))

Error: Error while executing a query in Impala: [HY000] : 

AnalysisException: Could not resolve column/field 

reference: 'current_date'

Workaround: In raw SQL query, the Current_Date  would not 

work with Impala, so instead of current_date, users can use 

now()  or current_timestamp().

213088 If Campaign is installed in a secured environment but IBM 

Cognos is in an unsecured environment, Cognos reports will 

not display when you use Microsoft Internet Explorer 11. 

Workaround: If Unica Campaign is configured with HTTPS, 

also configure IBM Cognos on HTTPS.

217488 IBM can support the Database Loader for Redshift until the 

moment Campaign triggers the Loader Script. Any problems 

in execution of the loader script are not supported by IBM.

223716 Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you can 

use the following workaround to ensure application security.

Complete the following steps to update web.xml.

1. Update the web app tag and set the xsd version to 

3.0.

<web-app 
 xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance"
  xmlns="http://java.sun.com/xml/ns/javaee"
 
 xsi:schemaLocation="http://
java.sun.com/xml/ns/javaee
 
 http://java.sun.com/xml/ns/javaee/web-app_3_0
.xsd"
  id="Platform" version="3.0" 
 metadata-complete="true">
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2. Add the following in web.xml.

<!--[start] WhiteList Http Verbs -->
<security-constraint>
  <web-resource-collection>
 
 <web-resource-name>Unica_WhiteList_Http_Verb
s</web-resource-name>
  <url-pattern>/*</url-pattern>
 
 <http-method-omission>GET</http-method-omissi
on>
 
 <http-method-omission>POST</http-method-omiss
ion>
 
 <http-method-omission>TRACE</http-method-omis
sion>
 
 <http-method-omission>PUT</http-method-omissi
on>
 
 <http-method-omission>DELETE</http-method-omi
ssion>
 
 <http-method-omission>PATCH</http-method-omis
sion>
 
 <http-method-omission>OPTIONS</http-method-om
ission>
 
 <http-method-omission>HEAD</http-method-omiss
ion>
  </web-resource-collection>
  <auth-constraint/>
</security-constraint>
<!--[end] WhiteList Http Verbs -->

283805
IBM Websphere Application Server 8.5.5 Fix Pack 12 

requires IFPI85892 to run HCL Unica application.

283544
On Oracle 12.2 database server following parameters 

needs to be added in sqlnet.ora file located under 

ORACLE_HOME/network/admin/SQLNET.ALLOWED_LOGON

_VERSION_SERVER

User will need to consult with DBA to provide appropriate 

value to this parameter. Please refer this link for details: 

https://docs.oracle.com/database/121/NETRF/sqlnet.htm#

NETRF2016
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N/A Campaign Integration with Watson Marketing Assistant is 

not supported on Internet Explorer.

286705 Two events get generated on the Campaign history tab 

when user pauses the Campaign flowchart from Operational 

monitoring.

287100 History tab data remains in UA_History table even after 

deleting the Campaign

290172 Cutting off right contents from Relevant offers window.

Workaround: The size of text, apps and other items - under 

Display should be set to 100%.

312318
Campaign flowchart run - when executed as complete 

flowchart generates a unique runID and its executed the 

flowchart along with mailchimp process box.

Next time when Campaign user tries to run the single 

process box - it does not generate unique runID and thus 

process box execution failed.

312296 HTTPS(Invalid certificate) HIP instance is not supported in 

IE11 for Link PB and Manage Link Connections page.

312320 MailChimp - Audience value is getting changed to other 

format f239295fe8 (in alphanumeric format) if we re-open 

correctly configured Link PB. The workaround is to hit the 

Fetch button adjacent to the field which will refresh the 

value of the user-friendly string value.

312567
Campaign installer failed to update Insights report files 

when installed using non-root user on Unix environment. To 

overcome this user would need to update Insights report file 

manually after installation is completed.

1. Navigate to <PLATFORM_HOME>/Insights/tools/bin/

2. For UNIX:
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• Grant read, write, and execute permissions to 

-bPath=<Report folder path>  for the installation 

user.

• Grant execute permission to the installation user 

using the following command.

chmod 755 insightsDBUtil.sh

3. Execute command to update the Campaign Insights 

report files.

./insightsDBUtil.sh -ds=CampaignDS -bPath=<Report folder 

path> -DBType=<databasetype> -URL=JDBC connection 

URL> -user=<database user> -pwd=<database password>

For more details refer 

UnicaInsights12_1InstallationConfigurationGuide

313216 Link: Unica application on HTTPS and unica Link on HTTP 

does not render the Manage links connections page.

Known limitations in Unica Optimize
Unica Optimize includes 25.1.1 includes the following known limitations.

Issue Number Description

Strings in the production or test pop-up 

window are not translated.

Defect 176920 In the case of a non-English setup, the strings in the 

production or test pop-up window are not translated.

The MailList process fails with the 

following database error: ORA-00999: 

INVALID VIEW NAME.

Defect 170951 Change the value of UseTempTablePool  from TRUE  to 

FALSE  in UA_SYSTEM_TABLES. The MailList run will end 

successfully.

Unica Optimize  does not terminate the 

unica_acsvr  process that is opened 

during a run.

Defect 164875 In case of a schedule run of a Unica Optimize  session by 

using the Unica Platform  Scheduler, you observe multiple 

unica_acsvr  login processes. These processes might 

terminate automatically after some time.

A DB2 database user change of system 

tables causes a Unica Optimize  session 

to fail when the administrator has an 

index with the same name.

Defect 155876 To avoid having a session fail, the DB2 database 

administrator should remove indexes.

In a Unica Optimize  report, offers by 

type and segment do not get printed as 

desired.

Defect 102889
The following issues were noticed while printing the offers 

by type and segment in a Unica Optimize  report.
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Issue Number Description

1. The preview window does not scroll, unless it is 

resized.

2. While printing it does not print everything, but only 

what fits in A4 size. Printing options do not seem to 

make any difference.

Negative scores cause inaccurate rules 

crediting.

DEF041400
If you use negative scores, rule crediting in the Offer Filtering 

Summary report might not be accurate.

Offers with negative scores are given to meet minimum 

requirements only.

Cells that are linked to TCS with offer 

assignments do not appear in Optimize 

process.

DEF061355 If the Optimize process is connected to one or more cells 

and the upstream cells are later linked to top-down cells 

defined in the Target Cell Spreadsheet process (TCS), the 

offers that are assigned in the TCS do not automatically 

appear in the Optimize process. Link to any top-down cells 

in the TCS before you connect those cells to an Optimize 

process. Otherwise, you must either manually assign the 

same offers within the Optimize process, or delete the 

Optimize process and re-create it.

Running the ACOOptAdmin utility with 

one-way SSL requires more setup.

DEF046832 You cannot use the ACOOptAdmin  utility with one-way 

SSL until you register a security certificate, specify a host 

name and domain, and configure SSL_Options in the 

ACOOptAdmin.bat  file.

Unable to run the session in first 

attempt when unica_acosvr process 

stopped.

DEF055010
If you use the kill  command to stop unica_acosvr, the next 

time you attempt to run a Unica Optimize  session, it might 

fail with the following error: An unknown communication 

failure has occurred with the  Optimize server process.

Workaround - Run the Unica Optimize  session again to 

complete it successfully.

Before you contact HCL technical support
If you encounter a problem that you cannot resolve by referring the documentation, your company's designated support 

contact can log a call with HCL technical support. Use these guidelines to ensure that your problem is resolved efficiently 

and successfully.

If you are not a designated support contact at your company, contact your HCL administrator for information.
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Information to gather

Before you contact HCL technical support, gather the following information:

• A brief description of the nature of your issue.

• Detailed error messages that you see when the issue occurs.

• Detailed steps to reproduce the issue.

• Related log files, session files, configuration files, and data files.

• Information about your product and system environment, which you can obtain as described in "System information."

System information

When you call HCL technical support, you might be asked to provide information about your environment.

If your problem does not prevent you from logging in, much of this information is available on the About  page, which provides 

information about your installed HCL applications.

Contact information for HCL technical support

For ways to contact HCL technical support, see the HCL technical support website: .

• Customer Support Portal or Website: https://support.hcl-software.com/csm

• Phone number(s): https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0010151

• Chat: https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0076941

• Email Address(es): https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0118964

• Submitting the form as a Guest: https://support.hcl-software.com/csm?id=guest_csm_creation

• Submitting a Support Ticket: https://support.hcl-software.com/csm?id=kb_article&sysparm_article=KB0010164
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